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1: How to convert word to PDF file in iPhone, iPad â€“ Best apps
Question: Q: Saving A Word Document on iPhone I received a Word document on my iphone as an email attachment. I
would like to save it so I can use it to send as an attachment in emails I send out.

The lack of a proper file system can be confusing, and something as simple as downloading a file can all the
sudden become a daunting task. How do I download a file to my iPhone? Where do I download it to? Apple
has made the lack of accessible file system a little easier to swallow over the past couple years, specifically
with the expansion of iCloud services but also with the Files app, a front facing app for most files stored in
iCloud. Apple has also opened things up to third-party applications. Dropbox is probably the most familiar
name in the space. Google Drive is also a popular option, and for those users who have limited iCloud storage,
these two services might be the best options to download files. They will be stored in the cloud and accessible
from the device, and in some cases, users will be able to download them for offline access. In which case, they
will be on the device itself as well. No matter what, files will have to be downloaded to a cloud service. It can
be iCloud, Dropbox, Google Drive, or other similar services. On your iPhone or iPad, go to Safari and open
the file you are trying to download. Tap on the Share button, which will bring up the Share sheet. From there,
you will be able to enable the Dropbox extension. Now tap the Save button, or choose a different folder where
to save the file, then tap Save. The file has now been saved to your Dropbox account and will be available for
easy access across all your devices, such as your computer, your iPhone, iPad, etc. Downloading files from a
password-protected website The steps mentioned above work great if the file you are trying to download is
available publicly from a website. But things can get a little tricky if you are trying to download a file or
document that is stored on a password-protected website. Here is how to use it to download a file from a
password-protected site. Login to whatever website you need to use to download a file or document. Locate
the file you want to download, and tap on it to load it. In the top right corner of the screen, tap on the upload
button. Documents 5 will then let you change the file name, if necessary, and select where you want to
download the file to. From Documents 5, you will then be able to move it to iCloud or Dropbox, or Google
Drive, for example. You will also be able to share it via email. It makes downloading and moving files around
a breeze. Because it can tie in to various cloud services, and let you access and move files between them,
Documents 5 can be the central location for all your file handling needs. Although not as simple as a drag and
drop gesture would be on a computer, As pointed out by ProllyWild in the comments section, Documents 5
can even let you move files around folders and cloud services by using a drag and drop gesture, making file
handling almost as simple as it would be on a desktop computer. To move a file, simply tap and hold your
finger on it, then drag it to your destination of choice. It can be a folder, or a cloud service such as iCloud,
Dropbox, etc. Downloading files on iPhone or iPad is a pain No matter how good you are at getting this
workflow down, it still feels like downloading files and documents from an iPhone or iPad is a giant pain in
the butt. Maybe this will be part of a future software update, especially now that Apple is trying hard to pitch
iPad as a work machine. As always, any questions or comments you may have are more than welcome.
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2: How to Transfer Word Document to iPhone
Once it is on your phone you can tap the Word document in your email to view it then tap the Share icon and Open in
Pages. If you edit the document and email it you will have the choice to send it as a Pages document, a Word document
or a PDF file.

For example, the document may be lost if an error forces Word to close, if you experience a power
interruption while you are editing, or if you close the document without saving changes. This article discusses
six methods that you can use to try to recover the lost document. Unfortunately, some documents might not be
recoverable. For example, if you have not saved the document at all, the whole document might be lost. If you
have saved your document, you might lose only the changes that you made since the last time that you saved
it. However, do not worry. Many documents can be partly or completely recovered. Because there are several
versions of Microsoft Windows, the following steps may be different on your computer. If they are, see your
product documentation to complete these steps. Also, because some of these methods include steps that
require you to restart your computer. You may find it easier to follow the steps if you print this article first.
More Information Use these methods in the order in which they are presented to recover the lost document. If
one of these methods is successful and you recover the lost document, you are finished and you do not have to
follow any more steps. Search for the original document The original document might not have been removed
from the computer. Follow these steps to see whether you can find the document: Click Start, and then click
Search. In the lower-left corner of the Windows Desktop Search pane, click Click here to use Search
Companion, if that option is listed. In the All or part of the file name box, type the name of the document that
you want to find. In the Look in box, click My Computer, and then click Search. If the search details pane
does not contain the document that you are looking for, you might have typed the file name incorrectly or the
document might have a different name. Follow these steps to search for all Word documents: In the Search
Companion pane, click Start a new search. Click All files and folders, and then copy and paste or type the
following text into the All or part of the file name: To view the Recycle Bin and restore the document if it is
there, follow these steps: On the desktop, double-click Recycle Bin. On the View menu, click Details. Scroll
through the files. If you find the document that you are looking for, right-click the document, and then click
Restore to return the document to its original location. Note Microsoft currently does not provide any utilities
to recover documents that have been deleted, or emptied from the Recycle Bin. However, some third-party
utilities to recover deleted documents may be available on the Internet. Search for Word backup files If the
previous method did not work for you, the main document might be gone. But there might be a backup copy
of the document available. The Always create backup copy setting in Word creates backup copies of every
document that you create. First, follow one of these steps to see whether the Always create backup copy
setting is enabled: If you use Microsoft Office Word Scroll through the headings until you find the Save
section, which is close to the end of the list. If the Always create backup copy setting, located in the Save
section, is selected, Word created a backup copy of the document. On the Tools menu, click Options. The
Always create backup copy setting is located on the Save tab. If the Always create backup copy setting is
selected, Word created a backup copy of the document. Then, if the Always create backup copy setting is not
selected, go to method 3: Locate the folder in which you last saved the missing document. Look for files that
have the. If there are no files that have the. In the All or part of the file name: If you find any files that are
named "Backup of" followed by the name of the missing document, follow these steps to open the backup
copy: Perform one of the following actions: If you use Word Force Word to try to recover a file If Word did
not create a backup copy of the document, you might be able to use the AutoRecover feature to recover the
lost document. Note The AutoRecover feature in Word performs an emergency backup of open documents
when an error occurs. Some errors can interfere with creating an AutoRecover file. The AutoRecover feature
is not a substitute for saving the document. If the Save AutoRecover information every [] minutes option is
selected, Word creates a temporary AutoRecover file that includes the latest changes in the document. Every
time that Word starts, it searches for AutoRecover files. If Word finds any AutoRecover files, it displays the
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files that it finds in the Document Recovery task pane. First, to see whether the Save AutoRecover information
every [] minutes option is selected, use one of the following steps: The Save AutoRecover information every
[] minutes option is in the Save documents section. Click Options on the Tools menu. The Save AutoRecover
information every [] minutes option is located on the Save tab. Then, if the Save AutoRecover information
every [] minutes option is selected, try closing Word and reopening it. If the AutoRecover task pane appears
on the left side of the screen, click the lost document to restore it. If the Save AutoRecover information every
[] minutes option is not selected, you can try to force Word to recover the document. Use one of the following
steps to force Word to recover the document: Click the Microsoft Office Button, click Open, select the Word
document, click the down arrow on the Open button in the lower-right corner of the Open screen, and then
click Open and Repair. Click Open on the File menu, select the Word document, click the down arrow on the
Open button in the lower-right corner of the Open screen, and then click Open and Repair. Manually recover
AutoRecover files If Word could not open the AutoRecover file automatically or through the Open and Repair
option, the AutoRecover file might be saved in a nondefault location. You might have to look for the
AutoRecover file manually. Follow these steps to search for AutoRecover files manually: If a file that is
named DocumentName. Follow one of these steps: Click the Microsoft Office Button, and then click Open.
Click Open on the File menu. Locate and select the. If this occurs, perform one of the following actions: In
Word , double-click the file in the Document Recovery task pane, click the Microsoft Office Button, click
Save As, and then save the document as a. In Word , double-click the file in the Document Recovery task
pane, click Save As on the File menu, and then save the document as a. Note If an AutoRecover file in the
Recovery pane does not open correctly, go to the "How to troubleshoot damaged documents" section for more
information about how to open damaged files. Search for temporary files If you could not find an
AutoRecover file or a backup of the lost document, you might be able to recover the document from your
temporary files. To search for the lost document in your temporary files, follow these steps: Click the two
chevrons next to When was it modified?. Click Specify dates, and then type the from and to dates to include
the time period since you last opened the file. On the View menu, click Arrange Icons by, and then click
Modified. Scroll through the files, searching for files that match the last dates and times that you edited the
document. If you find the document that you are looking for, go to the "How to troubleshoot damaged
documents" section for more information about how to recover information from the document. These files
might not appear in the list of temporary files that you found in method 5: How to troubleshoot damaged
documents Word automatically tries to recover a damaged document if it detects a problem with the
document. You can also force Word to try to recover a document when you open it. Follow these steps to
force Word to recover the document: Follow one of these steps, depending on the version of Word that you
use: In the Open dialog box, select the document. Click the down arrow on the Open button in the lower-right
corner of the Open screen, and then click Open and Repair. Search technical support information and self-help
tools for Microsoft products. View product-specific frequently asked questions and support highlights. If you
continue to have problems after you use these resources, you might want to contact Support:
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3: How can I save an image in word as a jpeg. - Microsoft Community
Reading Word document on iPhone used to be a challenge, but now it has been an easy task with iPhone's support for
it. iPhone users who used to handle with the documents on the computer can transfer Word document to iPhone.

It works on your browser to connect your iPhone to PC wirelessly. Then you can freely manage or transfer
various kinds of files on web, such as pictures, music, videos, and documents. Hence, if you wonder how to
save Word documents on iPhone, it is a wonderful method. The following guide can help you with the process
step-by-step. Click the button below to visit App Store and install the application on your iPhone. Connect
iPhone to web: Transfer Word to iPhone: Afterwards, you can disconnect on web or on your phone. Thus, it
can satisfy all your needs with the easiest operation. Transfer Document to Word app directly with Phone
Manager Apowersoft Phone Manager is a professional mobile devices management software used on the
computer desktop. Apart from comprehensive control of your mobile, it also allows you to transfer any data
from Android or iOS to PC and the other way around. The biggest advantage of using this tool to transfer
Word documents to iPhone is its capability of putting the documents into a Word app directly. Just stick to the
steps here. Download and install the application on your computer. Afterwards, choose a Word app which you
want to transfer the documents into. In this way, the word documents will be saved into the app. Then you can
use this Word application to read the files conveniently. Most file transfer apps cannot achieve this. Thus, this
Apowersoft Phone Manager could be worth trying. Sync Word to iPhone with latest iTunes iTunes has
updated to version However, the guide on Apple Support webpage still sticks to the old iTunes. If you have
downloaded the newest version, you will find the tutorial not applicable any longer. Therefore, this guide is
specially made for you about how to put Word documents on iPhone using iTunes Get the latest iTunes by
upgrading or downloading from its website. Then scroll down to the bottom of the window. By doing so, you
can also achieve what you want. Nevertheless, comparing to AirMore, this method has several shortcomings
you need to be aware of. The process is more complex. A USB cable is required. You need to install a desktop
client on your computer. You have to select the corresponding apps when you transfer various kinds of
documents. Actually, you can also adopt Gmail or iCloud to send Word documents to iPhone. But in general,
these three methods introduced in this article are the most popular ones. Without many efforts or operations,
all the documents will be transferred into your iPhone. Last updated on January 4, Leave a Comment.
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4: How to save a Pages document as a Word document
If you've received a document, such as a PDF, Word, or RTF file via email, text message, or other sharing method, or if
you're viewing it on the Web, tap the document on your iPhone to open a preview.

Which means you can use it a bit like you use Finder on your Mac. Create different folders for saving and
organizing different kinds of things like photos, PDFs, text files and more. But now Files app is here, you can
create different folders for saving inspiration photos, PDFs for receipts and more. Use Save to Files Extension
Step 1: This will bring up the Share sheet. From the bottom row, tap on Save to Files. By default, this will be
On my iPad and iCloud Drive. Select the folder where you want to save this file. Then tap on Add. The file
will be saved to the location. Images on a web page in Safari are a prime example. In times like these, a simple
drag and drop will do. First, open the Files app on your iPad in Split View more about that here. Then, tap and
hold on the file you want to add to the files app. In a second, it will lift up from the screen and a small preview
will be attached below where your finger is. Swipe to the Files app and drop the file in the folder you want to
add it to. If the file is in a compatible format like images, PDF, text file , it will be saved to the folder in Files
app. Tap and hold on a file and select Tags to get started. What is your favorite new feature in Files app? How
will you be using the app to organize your files and folders? Share with us in the comments below.
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5: Saving A Word Document on iPhone - Apple Community
Early versions of Apple's iPhone allowed you to view Word documents, but not save them to your phone. Now, however,
a variety of document-editing applications are available that allow you to view, create and edit Microsoft Office files.
Once an application has been installed, there are several methods of transferring your Word files to the iPhone.

Can the iPad be used to type documents? Can it open and save Microsoft Office files? Can it open and save
PDF files? The iPad most certainly can be used to type documents. Although Apple subsequently has released
versions of these apps for the iPhone and iPod touch, the small displays make the software much less
convenient for more than basic review and quick edits of documents, even with the assorted zoom
functionality. The iPhone and iPod touch models also can be used with keyboards, but when combined with
the larger display, an external keyboard makes it possible to comfortably compose full documents on the iPad.
However, it also is worth noting that because iOS software commonly is designed for use without a keyboard,
some apps may be awkward or "clunky" when used with a keyboard and allow some actions from the
keyboard whereas others will require touching the screen. Those used to typing on a Mac and using lots of key
commands may be disappointed by the iPad experience. For those who use Microsoft Office on a Mac or
Windows PC, and assuming full crossplatform compatibility and advanced features are important, the official
software is the best choice by far. Originally, Office for iPad was free to download, but the free version only
allowed you to read Word, Excel, and PowerPoint files. Editing files or creating new ones required an Office
subscription. However, on November 6, , Microsoft relaxed this requirement and made basic editing free for
consumers, with more advanced business features still requiring Office Starting today November 6, , people
can create and edit Office content on iPhones, iPads, and soon, Android tablets using Office apps without an
Office subscription. Of course Office subscribers will continue to benefit from the full Office experience
across devices with advanced editing and collaboration capabilities, unlimited OneDrive storage, Dropbox
integration and a number of other benefits. In addition to helpful reviews from Macworld and ArsTechnica ,
you also may find this demo video from Microsoft worthwhile to see the software in action: Originally only
Pages supported saving documents in Word format, but Numbers and Keynote did not support saving
documents in Excel or PowerPoint, respectively. Thankfully, this subsequently has changed and Numbers and
Keynote now both can save files in the equivalent Microsoft format. More recent Apple marketing copy
shamelessly declares that these apps "now work even better with Microsoft Word, Excel and PowerPoint.
Always optimistic marketing copy aside, the straightforward lists of exactly what works, may work, and does
not work definitely is welcomed and should help users have realistic expectations. Likewise, from the
extensive number of "partially" supported and unsupported features when converting between formats, it is
clear that experiences still will continue to vary significantly. Although the professional opinions below are
referring to the original release of the iWork suite for iPad, they still do an excellent job demonstrating the
range of possible translation outcomes using the official Apple solutions. When I downloaded the template for
the Word document I am currently using for this review, the iPad automatically asked if I wanted to convert it
to a Pages doc. When I did, I was immediately using a doc that looked exactly like my original Word
document. This is a serious content creation app that should help the iPad compete with laptops and can
import Microsoft Office files. In one case, the exported Word file had misaligned text. When I then tried
exporting the document as a PDF file, it was unreadable. In addition to the official solutions, two other
translation apps include Documents To Go from DataViz , which has been providing Mac format translation
software for decades, and newcomer QuickOffice , which now is owned by Google. More recently, Apple
released newer " dumbed down " versions of Pages, Numbers, and Keynote in an effort to bring more parity
between the Mac and iOS versions. Although this may have been well meaning -- the backlash from
consumers was swift and substantial -- and Apple promised to bring back at least some of the features
removed or broken by the new release. Since then, some features have been added back, but the software
remains a work in progress. When using any version of Pages, Numbers, or Keynote for the Mac, changes
typically are more minor than those converting between Microsoft applications and their Apple equivalent, but
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some of these changes still are quite significant. Likewise, removing the comments in a presentation could
range from frustrating to devastating if you were planning to review them prior to your presentation and only
then discovered that they were gone. As Apple makes the applications for both systems, and the company no
doubt wants to encourage sales of both Macs and iPads -- or at least encourage migration from the Mac to the
iPad -- one certainly would hope that compatibility will continue to improve as long as Apple views Mac
compatibility as important for iWork. It certainly appears that the company continues to work on this goal.
Compatibility of the original version definitely was overstated, as the below journalists note. If you are
planning on buying an iPad to be a portable editing device for your iWork content -- think twice. The Apple
Discussion boards are all aflutter with teachers and professors who hoped they could leave their laptops in the
office and only take their new iPads to the lecture hall. This is not the case. Although Apple has branded the
programs the same as the versions you can buy for your Mac, this is where the similarity ends. Formatting is
lost in Pages so formulas and footnotes disappear in Keynote transitions and builds go away. It is not as if they
are temporarily suspended while on the iPad they are gone so when and if you save back to your Mac they are
no longer there. Thankfully, this previously permanent file change issue has been rectified. You now will be
"prompted whether you would like to open the original version or to create a copy, and changes made to the
content or document layout are listed for your review. As always, keep a backup of a file before attempting to
convert between any formats. It may be of interest, too. With the official Microsoft Office for iPad software,
when combined with an Office subscription and a physical keyboard , it is simple to read, edit, and create
Word documents, Excel spreadsheets, and PowerPoint presentations, generally even in a collaborative
environment where documents will be sent back and forth between multiple parties for revision. Translation
efforts are improving, but as they always have been since the dawn of time, work best for simple documents.
6: How to add Word, Excel and PowerPoint documents to iPhone or iPad?
With Office for iPhone, your files are saved automatically. This is called AutoSave. And you can see that AutoSave is on
when this button has 2 arrows. You can also see it's on when you tap the button. With AutoSave on, Excel, PowerPoint
and Word save frequently for you, so you don't have to worry about it.

7: Saving Excel or Word Files on Your iPhone | It Still Works
As of iOS 8, the iPhone doesn't come with any apps that can open Microsoft Word documents, but Microsoft has an
official, free Word app in the App Store. If you have an Office account, the app offers more features, but you don't need
a subscription to view and make basic changes to a document.

8: How to Save Documents from Anywhere to Files App on iPhone and iPad in iOS 11
How to save email attachments to Dropbox, Google Drive, OneDrive or enterprise storage on iPhone or iPad Thanks to
document provider extensions, though, you can also save to Dropbox, Google Drive, OneDrive, and other storage
services.

9: How to Save a Word Document as a Picture | HowStuffWorks
Hi my husband has an iPhone 6s Plus and it is updated, but since the 2nd last update his signature has not been
working. It will come up just fine but once he sends off the document it gets back unsigned.
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